WCCP op FTD configureren en problemen
oplossen met behulp van vooraf gedefinieerde
sjabloon
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Inleiding

Dit document beschrijft de stappen voor de configuratie en probleemoplossing van WCCP op
FTD.

Voorwaarden

Vereisten

Cisco raadt kennis van de volgende onderwerpen aan:

* Web Cache Communications Protocol (WCCP) versie 2 (v2)
» Firepower Management Center (FMC)
» Firepower Threat Defense (FTD)

Gebruikte componenten

De informatie in dit document is gebaseerd op de volgende software- en hardware-versies:

» Secure Firewall Management Center (FMCv) v7.4.2
» Secure Firewall Threat Defense Virtual (FTDv) v7.4.2

De informatie in dit document is gebaseerd op de apparaten in een specifieke
laboratoriumomgeving. Alle apparaten die in dit document worden beschreven, hadden een
opgeschoonde (standaard)configuratie. Als uw netwerk live is, moet u zorgen dat u de potentiéle



impact van elke opdracht begrijpt.

Configureren

Web Cache Communication Protocol (WCCP) wordt gebruikt om webverkeer naar een
cacheserver te verwijzen. Het wordt meestal geimplementeerd in netwerkapparaten zoals Cisco-
routers en -firewalls om HTTP-, HTTP- en FTD-over-HTTP-verzoeken naar een proxyserver te
sturen.

WCCP is beschikbaar in verschillende versies, waaronder WCCP v1, v2 en v3, waarbij elke versie
verbeterde functies en schaalbaarheid biedt.

Hoe het werkt

» Gebruiker machine Win10-0 doet een HTTPS-verzoek.

» Hier is de FTD Firewall de gateway voor de gebruiker-pc. Het ontvangt het HTTP/HTTPS-
verzoek.

* FTD begrijpt dat de bestemmingshaven 443 is en leidt het verkeer naar DMZ om

+ DMZ kapselt het pakket met GRE in en verstuurt het verzoek naar de Proxyserver.

» Proxyserver kijkt in zijn cache of start een nieuwe verbinding met de oorspronkelijke server
en reageert direct op de gebruikersmachine.

Netwerkdiagram
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Configuraties

Deze stappen tonen de configuratie voor WCCP op FMC aan. Het verkeer met poort 80 en 443
moet worden omgeleid van de Inside zone naar de DMZ zone.



Opmerking: Het document beschrijft de stappen voor dynamische service-id. De
poortinformatie is van de WCCP-client geleerd.

Stap 1: Log in op FMC GUI en navigeer naar Object > Objectbeheer > Toegangslijst > Uitgebreid
> Uitgebreide toegangslijst toevoegen.

Maak twee uitgebreide toegangslijsten.

1) Maak een toegangslijst aan om gebruikersverkeer om te leiden en klik op Opslaan.



Edit Extended Access List Object

Name

I Redirect_traffic

Entries (3)

ation U
@ Block  WSA_server S o
2 © Block user_LAN S E
3 Allew u
Allow Overrides

Opmerking: Deze toegangslijst zorgt ervoor dat u Action Block hebt voor verkeer dat van
WCCP-client naar FTD komt om loop in het netwerk te voorkomen.



Daarnaast kunt u een andere verklaring met Action Block maken om ervoor te zorgen dat

de communicatie tussen interne hosts niet naar proxyserver wordt verzonden.

De definitieve verklaring moet al ander verkeer toestaan dat voor omleiding aan de

volmacht in aanmerking komt.

2) Maak een toegangslijst om de WCCP-client te identificeren en klik op Opslaan.

Name
[ wece-cuen

Entries (1)

1 = Allow WSA_server

Allow Overrides

Toegangslijst om de WCCP-client te identificeren



Opmerking: De configuratie van een uitgebreide toegangslijst met de IP-adressen van de
WCCP-server.

Stap 2: Navigeer naar Object > Objectbeheer > FlexConfig > Tekstobject > Tekstobject toevoegen
om WCCP-service en -opslag toe te voegen.



Edit Text Object T

Mame:

Description:
Variable Type Count
Single v 1
1 a7
|| Allow Overrides

| Cancel | Save

WCCP-serviceobject maken



Opmerking: In dit voorbeeld is de service-id 97. U wordt aangeraden een Service-I1D
tussen 90 en 97 te selecteren, aangezien dit aangepaste service-ID’s zijn die doorgaans
niet in strijd zijn met andere service-ID’s die aan specifieke protocollen zijn toegewezen.

Raadpleeg voor meer informatie WCCP op ASA: Concepten, beperkingen en configuratie
Stap 3:

» Navigeer naar Object > Objectbeheer > FlexConfig > Tekstobject en zoek naar
isServiceldentifer.

Text Object ['\"« isServiceldentifie] b4

Text objects define free-form text strings that you use as variables in a FlexConfig object. These objects can have single values or be a list of multiple values


https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html
https://www.cisco.com/c/en/us/support/docs/security/adaptive-security-appliance-asa-software/116046-config-wccp-asa-00.html

» Wijzig isServiceldentifer van vals naar waar.
+ isServiceldentifer - Bij fout wordt de standaard web-cacheservice identifier gebruikt.
Raadpleeg de configuratiehandleiding van het document_Firepower Management Center

Edit Text Object @

Name:

iIsServiceldentifier

Description:

A flag to identity whether to use
service in wecep.

Variable Type Count
Single v =
1 true

Allow Overrides

» Override (0)

Wijzig de waarde van vals naar waar



https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html
https://www.cisco.com/c/en/us/td/docs/security/firepower/70/configuration/guide/fpmc-config-guide-v70/flexconfig_policies.html

Opmerking: Daarnaast kunt u een door de gebruiker gedefinieerd Tekstobject maken dat
in stap 2 wordt weergegeven.

Stap 4:

* Navigeer naar Object > Objectbeheer > Flex Config > FlexConfig Object.
» Zoeken naar trefwoord wccp.
+ Kiik op de kloonoptie voor de WCCP_Configure sjabloon.
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Application Filters

AS Path Ham ’ '

EBFD Template

Weep_Configure The tempdate is an example of woep configur.. Ba

Cipher £ I

» Community List o £ I . =

DHCP IPv6 Pool
> Distinguished Name

» External Attributes
File List
"~ FlenConfig
FlexConfg Object
Text Object

Opmerking: Het object FlexConfig heeft een vooraf gedefinieerde sjabloon:
WCCP_Configure. De sjabloon kan niet aan het apparaat worden gekoppeld. Je moet het



klonen.

Stap 5:

« Verwijder de $serviceldentifier variabelen uit de derde regel en geef je eigen variabele op.
Add FlexConfig Object (7]

Name:

Wccp_Configure_clone

Description:

The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.
Insert » Deployment: Once v Type: Append v

#set( Sservice = "web-cache")

#if( $isServiceldentifier == "true")
fset( Sservice = "$sepviceldentifier")
#end —

#set ( SwccpCli = "wccp")

roupList with extended ACL defined in FMC by inserting policy-object of type extended ACL.
#if ( $wecpGrouplist )

................... g

####wccpRedirectlist is place-holder for extended ACL.
####Replace wecpRedirectlList with extended ACL defined in FMC by inserting policy-object of type extended ACL.

fif{ SwocpRedirectList )

fset( SweepCli = "SweepCli redirect-list $wegpRedirectList"™)
fend
¥ Variables
Name Dimension Default Value Property Override Description
(Type:Name) P
isServiceldentifier SINGLE true FREEFORM:I... false A flag to determine if service ...
serviceldentifier SINGLE 1 FREEFORM.... false service identifier number is to...

Cancel Save

De service-ID verwijderen

» Plaats de Text Object-Service als de variabele die in stap 2 is gemaakt.
» Selecteer in het vervolgkeuzemenu Invoegen > Beleidsobject invoegen > Tekstobject



Add FlexConfig Object

Name:

[
Weep_Configure_clone

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

|. Insert . B Deployment: ' Once v | Type: ' Append

| Insert Policy Object Text Object

Insert System Variable » Network

Insert Secret Key Security Zones
#set ( SwecepGli = "Sweg .
####wccpGroupList is pl Standard ACL Object 3 acr.
f###Replace wecepGroupLi afined in FMC by inserting policy-object of type extended ACL.

§if ( $wecpGroupl Extended ACL Object

#set( SwecpCli =

#end Route Map

fend

Voer het wcp-service object als variabele in

» Verleen variabele Namewcp-service.
« Zoeken naar wccp-service-object in beschikbaar object.
* Voeg het object toe en sla het op.



Insert Text Object Variable (7]

Variable Name:

| wecep-service ‘

Description:
Available Objects Selected Object
| 2, weep b4 ‘ weep-service-object .

WCCp-=-5erv [ ce-o

wecepPassword

Cancel Save

WCCP-service object toevoegen

Stap 6:

» Kopieer de wcepGrouplList variabele naam en geef uw eigen variabele.



Add FlexConfig Object

Name:

[ Wecep_Configure_clone l

Description

The template is an example of
weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

l Insert » s Deployment: | Once v Type: Append v

#set( $service = "web-cache")

#if( $isServiceldentifier == "true")
#set( $service = "$wecp-service")
fend

: ####wcocpGrouplist
] ####Replace weoopGr List with extended ACL defined in FMC by inserting policy-cbject of type extended ACL.
Sl if ( $WCCPGroupList

t is place-holder for extended ACL.

#end

- A

Vooraf gedefinieerde wccpGroupList-variabele verwijderen

» Van vervolgkeuzemenu Invoegen > Beleidsobject invoegen > Uitgebreid ACL-object.

Name:

| Weep_Configure_clone

Description:

The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

r y .
|

Insert v i % Deployment: Once v Type: | Append

. Insert Policy Object Text Object

Insert System Variable »  Network

Insert Secret Key Security Zones

Standard ACL Object i ACL.

:fined in FMC by inserting policy-object of type extended ACL.
Extended ACL Object

#end

¥ Variables

WCCP-groepslijst uitgebreid ACL toevoegen

» Plakt de naam wcepGrouplList die u in de vorige stap in sectie Variabele Naam hebt



gekopieerd.
» Zoeken naar WCCP-CLIENT in beschikbare objecten die in stap 1 zijn gemaakt.
* Voeg en bewaar deze.

Dttt ettt ieiiiiiiiiiiiiiiiieiiiiiiiieiiiiaooen

Insert Extended Access List Object Variable (7]

Variable Name:

; ‘ wccepGrouplList |

f Description:

' Available Objects C Selected Object

| | search X | Bvcep-CLIENT ¥
'ij '—!?edirect_traﬂﬁc

& NCCP-CLIENT

Uitgebreide lijst met WCCP-CLIENT toevoegen
Stap 7:

» Selecteer wcepRedirectList om uw eigen variabele te kopiéren en te verstrekken.



Add FlexConfig Object

Name:

( Weep_Configure_clone ]

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v Deployment: I Once v ‘ Type: | Append
f#set ( $service = "web-cache")
#if( $isServiceldentifier == "true")

####Replace wecpRedirectList with extended ACL defined in FMC by inserting policy-object of type extended ACL.
=——P-iif | SwWccpRedirectList )

#end

WCCPredirectList verwijderen

+ Selecteer in het vervolgkeuzemenu Invoegen > Beleidsobject invoegen > Uitgebreid ACL-
object .

Add FlexConfig Object

Name:

I Weep_Configure_clone ]

Description:

The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v J k2 Deployment: [ Once v Type: | Append

ll Insert Policy Object Text Object

Insert System Variable » Network

Insert Secret Key Security Zones
#set ( SWEGPCLL = "$WCC )
###4wccpGroupList is pl Standard ACL Object 4 acr.
####Replace wcepGroupLil . pfined in FMC by inserting policy-object of type extended ACL.
#if( ) Extended ACL Object
#set( SweepCli = "Swecp oupList")
#end Route Map

####wccpRedirectlist is place-nolaer ror extended ACL.

#end

¥ Variables

Selecteer uitgebreid ACL-object voor wccpRedirectList



» Plakt wcepRedirectList in variabele naam.
» Zoeken naar Redirect_traffic in beschikbaar object.
» Selecteer Add en Save it.

et R

Insert Extended Access List Object Variable @

Variable Name:

‘ wccpRedirectList ‘

Description:

Available Objects C Selected Object
‘ Q Search p. % Lﬁlecjirect_traﬂﬁc

3 z Redirect_traffic

‘#VCCP-CLIENT

)

Redirect_traffic ACL toevoegen

Stap 8:

e @wccpPassword verwijderen



Add FlexConfig Object

Name:

[ Wecep_Configure_clone ‘

Description:
The template is an example of
wccep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

| Insert v

3 Deployment: [ Once v | Type: [ Append

FMC by inserting policy-object of type extended ACL.

t is place-holder for extended ACL.
irectList with extended ACL defined

in FMC by inserting policy-object of type extended ACL.

#foreach( $interfaceName in $security-zone)

Het vooraf gedefinieerde wcppassword verwijderd

+ Selecteer de toets in het uitrolmenu Invoegen > Secret Key invoegen.

Add FlexConfig Object

Name:

' Weep_Configure_clone ‘

Description:

The template is an example of
weep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

‘. Insert v ' k2 Deployment: [ Once v l Type: [ Append

Insert Policy Obiect » ace-holder for extended ACL.
v =0 st with extended ACL defined in FMC by inserting policy-object of type extended ACL.
In m Variable »
sert Syste ariable Cli group-list $weepGroupList™)

Insert Secret Ke
place-holder for extended ACL.

in FMC by inserting policy-object of type extended ACL.

#set( SweepCli = "SweepCli password ")

#foreach( $interfaceName in $security-zone)
¥ Variables

Selecteer geheime sleutel

+ Klik op Geheime sleutel toevoegen.




Insert Secret Key @

Add Secret Key

Name

~,
«

[ ] wccpPassword

Cancel Save

Voeg geheime sleutel toe

* Voer een naam in bij de naam van de geheime sleutel.
* Voer het wachtwoord in.
» Voer hetzelfde wachtwoord in Wachtwoord bevestigen en klik op Toevoegen.



Add Secret Key

Secret Key name:*

‘ wccpPassword J

Password:*

[ Cancel ] Add

Door gebruiker gedefinieerde geheime sleutel toevoegen




Opmerking: In dit voorbeeld, de binneninterface behoort tot Security Zone in.

Stap 9:

 Kopieer de vooraf gedefinieerde security-zone en vervang de $ security-zone door uw eigen
variabele.



Edit FlexConfig Object

Name:

| Weep_Configure_clone |

Description:

The template is an example of
weep configuration. It can not

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

Insert v ‘ (3 Deployment: | Once v | Type: | Append

#seﬁ[ E
fend

fforeach( $interfaceName in $SECUrity-ZONe |
weep interface $interfaceName §service redireet in

fend
¥ Variables
. Property . .

Name Dimension Default Value (Type:Name) Override Description
wcepGrouplist SINGLE WCCP-CLIENT EXD_ACL:W... false

wcecp-service SINGLE 97 FREEFORM:... false

interfaceName SINGLE in SECURITYZ... false

security-zone SINGLE in SECURITYZ... false

Kopieert de naam security-zone.

» Selecteer Beveiligingszones in het vervolgkeuzemenu en invoegen > Beleidsobject
invoegen.



Add FlexConfig Object

Name:

Wecep_Configure_clone

Description:

The template is an example of
wcep configuration. It can not be

A Copy-pasting any rich text might introduce line breaks while generating CLI. Please verify the CLI before deployment.

[ Insert B2 Deployment: I Once v | Type: I Append
Insert Policy Object Text Object supList™)
Insert System Variable »  Network wded ACL.
. defined in FMC by inserting peolicy-object of type extended ACL.
Insert Secret Key Security Zones
#SEL( PWCCPLLl = "3WCCE JRedirectList”)
$end Standard ACL Object

¥set( SwccpCli = "Sweep Extended ACL Object  yord ")
SweepCli Route Map

##4# RAssiging wcop onto interface
#foreach( in $security-zone)

#end

¥ Variables

Selecteer de beveiligingszone

» Plakt de variabele Naam als veiligheidszone.

« Selecteer uit de lijst Beschikbare objecten de interface die u wilt toevoegen.
* Klik op Save (Opslaan).



Insert Security Zone Variable (7]

Variable Name:

| security-zone |

Description:

Available Objects Selected Object
| C, Search ‘ in

o/

dmz

out

Cancel Save

De veiligheidszone toevoegen

Stap 10:

* Navigeer naar Apparaten > FlexConfig, klik op Nieuw beleid of bewerk een bestaand beleid.
» Selecteer het geconfigureerde WCCP_Configure_clone object en klik > om het toe te wijzen.
+ Klik op Save (Opslaan).



Opmerking: Voor een Nieuw Beleid, zorg ervoor dat u het Beleid aan FTD-apparaat
toewijst. Voor een bestaand beleid moet het beleid al toegewezen zijn.

WCCP_config " E=Z3

Wetp_ Condgure_clone

<7 Selected Append FlexConfigs

Stap 11: Navigeer naar Implementeren > Selecteer het FTD-apparaat > klik op Implementeren.



Verifiéren

Stap 1: Controleer de actieve configuratie.
Log in op FTD CLI en voer de opdracht show running-config wecpuit.

Configuratievoorbeeld:

wccp 97 redirect-1ist Redirect_traffic group-Tist WCCP-CLIENT password ###*%*%*
wccp interface inside 97 redirect in

Om er zeker van te zijn dat de configuratie het juiste wachtwoord heeft, voert u de opdrachten uit.
1) system support diagnostic-cli

2) enable

3) Druk op Enter zonder wachtwoord

4) more system:running-config | include wecp

Stap 2: Controleer de WCCP-status

De opdracht uitvoeren show weep

Global WCCP information:
Router information:
Router Identifier: -not yet determined-
Protocol Version: 2.0

Service Identifier: 97

Number of Cache Engines: 1

Number of routers: 2

Total Packets Redirected: 0

Redirect access-1ist: Redirect_traffic
Total Connections Denied Redirect: 0

Total Packets Unassigned: 0

Group access-Tist: WCCP-CLIENT
Total Messages Denied to Group: 0

Total Authentication failures: 0

Total Bypassed Packets Received: 0

De opdracht uitvoeren wccp 97-service tonen

WCCP service information definition:



Type: Dynamic

Id: 97
Priority: 240
Protocol: 6
Options: 0x00000012
Hash: DstIP
A1t Hash: -none-
Ports: Destination:: 80 443 000000

Opmerking: Hier is 97 de service-id. Zorg ervoor dat u het poortnummer kunt zien dat u
hebt geleerd van WCCP-client in poorten: deel.

3) Run the command show wccp 97 view

Problemen oplossen



Stap 1: Controleer of FTD de route heeft van dezelfde interface die het WCCP-verzoek van de
Proxyserver heeft ontvangen.

In dit voorbeeld wordt verkeer naar de mz-interface omgeleid.

>show route
S 10.xx.xx.xx 255.yyy.yyy.yyy [1/0] via 10.zz.zz.z, dmz

Opmerking: Hier 10.xx.xx.xx is proxy server IP, 255.yyy.yyy.yyy is Netmask, 10.zz.zz.z is
de volgende hop gateway.

Stap 2: Neem de opnamen binnen en dmz-interface om er zeker van te zijn dat het verkeer wordt
omgeleid.

Opname op Inside interface voor poort 443



capture capinside interface inside trace detail match tcp any any eq 443

Opname op dmz-interface:

capture capdmz interface dmz trace detail match gre any any

Opmerking: Op de dmz interface moet u filteren met GRE-protocol. Het redirect pakket is
ingekapseld in GRE pakket naar wcep client.

Stap 3: Debug voor wcep

Voer de opdrachten uit:



debug weep event debu weep packet

De Cisco-bug IDCSCvn90518 is verhoogd zodat de ondersteuning van de FDM en FMC native
mode is voor WCCP-configuratie.



https://tools.cisco.com/bugsearch/bug/CSCvn90518

Over deze vertaling

Cisco heeft dit document vertaald via een combinatie van machine- en menselijke
technologie om onze gebruikers wereldwijd ondersteuningscontent te bieden in hun eigen
taal. Houd er rekening mee dat zelfs de beste machinevertaling niet net zo nauwkeurig is als
die van een professionele vertaler. Cisco Systems, Inc. is niet aansprakelijk voor de
nauwkeurigheid van deze vertalingen en raadt aan altijd het oorspronkelijke Engelstalige
document (link) te raadplegen.



